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General Instructions: 

1. Read the instructions very carefully. 

2. This Question Paper consists of 21 questions in two sections: Section A & Section B. 

3. Section A contains Objective type questions; Section B contains Subjective type questions. 

4. Out of the given (5 + 16 =) 21 questions, a candidate has to answer (5 + 10 =) 15 questions in the 

allotted time of 2 hours. 

5. All questions of a particular section must be attempted in the correct order. 

6. SECTION A — OBJECTIVE TYPE QUESTIONS (24 MARKS): 

a. This section has 05 questions (Q.1 to Q.5). Each question contains 6 sub-parts; answer as 

instructed. 

b. No negative marking. 

7. SECTION B — SUBJECTIVE TYPE QUESTIONS (26 MARKS): 

This section has 16 questions (Q.6 to Q.21). A candidate has to do 10 questions. Do as per the 

instructions given 
 

 SECTION A: OBJECTIVE TYPE QUESTIONS  

Q-1 (Answer any 4 out of the given 6 questions on Employability Skills (4 × 1 = 4 marks)  

i. Samira moved from Brazil to Japan and finds it hard to understand local workplace habits 

which affects teamwork. This is an example of a_________________._ 

(1) 

 (A) Emotional barrier (B) Cultural barrier  (C) Legal barrier (D)  Technological barrier 
   

ii. After working non-stop for several weeks, Neil experiences constant tiredness and reduced 

concentration. This condition best illustrates: 

(1) 

 (A) Burnout  (B)Time management  (C) Networking (D) Delegation  
   

iii. Which software component boots first when a computer is turned on and manages files, 

processes and hardware? 

(1) 

 (A) Driver (B) Operating System  (C) Application Suite (D) Utilities  
   

iv. An entrepreneur should evaluate opportunities and be willing to take a ________ when needed 

to expand operations. 

(1) 

 (A) Large inventory (B) Calculated risk  (C)  Personnel cut  (D) Fixed contract  
   

v. The United Nations Sustainable Development Goals include targets such as: (1) 

 (A) Quality education (C) Reduced inequalities   

 (B) Affordable clean energy (D) All of the above   
      

vi. In the SMART goal framework, the letter 'R' stands for: (1) 

 (A) Reliable (B) Realistic (B) Rapid (D) Random  
      

Q-2 Answer any 5 out of the given 6 questions (5 × 1 = 5 marks)   

i. A user wants to copy formatting from one paragraph to several others without repeating the 

manual steps. Which feature can he/she use and how to stop it? 

(1) 

 (A) Use Format Brush; stop by clicking it again or pressing Esc  

 (B) Use AutoStyle; stop by closing document  

 (C) Use Manual Format; stop by saving  

 (D) Use Replace Formatting; stop by undoing  
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ii. Rahul modified some text and wants to update the existing paragraph style so changes reflect 

everywhere that style is used. Which action should he take? 

(1) 

 (A) copy and paste (B) update style  

 (C) change formatting  (D) undo  
      

iii. Sara needs a list at the start of her report that updates automatically and links to headings so 

readers can jump to sections. Which feature will she use? 

(1) 

 (A) Index of Terms (B) Hyperlink list   (C) Table of Contents (D) Glossary  
      

iv. Assertion (A): In spreadsheet software, a macro written as a Function can return a value that 

other cells can use. 

Reason (R): A function macro is defined between Function ... End Function and may accept 

parameters and return a value 

(1) 

 (A) Both A and R are true, and R explains A  

 (B) Both A and R are true, but R does not explain A  

 (C) A is true, R is false  

 (D) A is false, R is true  
   

v. Which feature in Calc allows combining summary results from multiple spreadsheets into one 

sheet? 

(1) 

 (A) Consolidation (B) External Linking  (C) Solver (D) Data Validation  
   

vi. To accept or reject tracked edits in a shared Calc file, which menu path is used? (1) 

 (A) Tools > Track Changes > Accept/Reject  

 (B) File > Versions > Review  

 (C) Edit > Changes > Manage  

 (D) View > Track Changes > Manage  
   

Q.3 Answer any 5 out of the given 6 questions (5 × 1 = 5 marks)  

i. After inserting a Table of Contents, it shows no entries. The most probable cause is: (1) 

 (A) No headings were assigned proper heading styles  

 (B) TOC was set to invisible  

 (C) Document is read-only  

 (D) Title wasn't renamed  
   

ii. Employees complain of frequent eye strain and lower-back ache at their desks. These are 

examples of: 

(1) 

 (A) Chemical hazards  (B) Ergonomic hazards    

 (C) Biological hazards (D) Radiation hazards  
   

iii. When two or more fields together uniquely identify a record in a table, that key is called: (1) 

 (A) Composite key  (B) Primary key (C) Foreign key   (D) Surrogate key  
    

iv. If a column is defined as VARCHAR(80) and an entry of length 30 is stored, the storage 

occupied is typically: 

(1) 

 (A) 30 bytes (B) 80 bytes (C) 160 bytes (D) 1 byte  
   

v. Which data model is most commonly used when the design emphasizes tables with relations 

between them for general business applications? 

(1) 

 (A) Relational model  (B) Hierarchical model   

 (C) Network model  (D) Flat-file model  
   

vi. The Query Design area in a database tool usually contains how many main panes (for adding 

tables, showing fields and criteria)? 

(1) 

 (A) two (B) three (C) four (D) one  

   

Q.4 Answer any 5 out of the given 6 questions (5 × 1 = 5 marks)  

i. Which keyboard shortcut opens the Templates manager in Writer? (1) 

 (A) Ctrl + Shift + O (B) Ctrl + Shift + N (C) Ctrl + Alt + T (D) Ctrl + T  
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ii. To combine data from four sheets into one summary and keep it linked to source updates, 

which feature and option is correct? 

(1) 

 (A) Consolidate — Link to source data enabled  

 (B) Pivot Table — Consolidate option enabled  

 (C) Data Grouping — Auto update option  

 (D) Data Merge — Live link option  
   

iii. Which statement about database forms is incorrect? (1) 

 (A) Forms provide a friendly interface for data entry  

 (B) Each form field usually has a label and an input control  

 (C) Forms are used to permanently store data like tables  

 (D) Forms can include images and explanatory text  
   

iv. In order to reduce workplace stress and conflict among colleagues, the best organisational step 

is to: 

(1) 

 (A) Provide conflict management training and flexible breaks  

 (B) Replace all office chairs  

 (C) Limit communication channels  

 (D) Increase working hours  
   

v. Jeya wants the monthly EMI to be exactly ₹8,500 by varying the loan period while keeping 

loan amount and rate fixed. Which feature should she use? 

(1) 

 (A) Goal Seek (B) Scenario Manager (C) Consolidate    (D) Solver  
   

vi. Which class correctly matches volatile metals (like magnesium) used in some industries? (1) 

 (A) Class A (B) Class B (C) Class C (D) Class D  
      

Q.5 Answer any 5 out of the given 6 questions (5 × 1 = 5 marks)  

i. Priyanka needs 12 formatted proposal documents that share the same header, footer, and 

styles. Which feature should she create and use? 

(1) 

 (A) Template (B) Macro   (C) Style Set (D) Table of Contents 
    

ii. When the Report Wizard launches in a database application, which helper normally opens to 

let you add fields to the report? 

(1) 

 (A) Add Fields dialog (B) Chart Builder (C) Macro Recorder  (D) SQL Editor  
      

iii. As part of disaster preparedness, floor supervisors must frequently conduct a ________ to 

practise safe exit procedures. 

(1) 

 (A) Team outing  (B) Evacuation drill (C) Inventory check  (D) Safety talk  
    

iv. Which sequence correctly describes the first steps after someone suffers a serious fall at work? (1) 

 (A) Assess scene → call for help → provide first aid  

 (B) Hide incident → continue work → report later  

 (C) Move victim immediately → inform HR → log incident  

 (D) Take photos → post on social media → inform manager  
   

v. To maintain a safe workstation, which combination of actions is best? (1) 

 (A) Keep desk clutter-free, clear walkways, clean spills immediately, report broken lights  

 (B) Only tidy personal desk; common areas left to cleaning staff  

 (C)  Ignore minor spills and wait for end of day  

 (D) Move furniture as needed without reporting faults  
   

vi. Two managers are working on separate copies of the monthly budget file. Which correct steps 

should an operator follow to compare and merge the approved content? 

(1) 

 (A) Use Compare Document to view differences and Merge Document to accept changes  

 (B) Overwrite one file with the other without checking  

 (C) Manually copy cells between files only  

 (D) Use Export as PDF and combine  
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 SECTION B: SUBJECTIVE TYPE QUESTIONS  

 Answer any 3 out of the given 5 questions in (20–30 words) (3× 2 = 6 marks)  

Q.6 Define any two elements of active listening and give one practical tip for each.  (2) 
   

Q.7 Reena frequently loses her temper at work. Suggest two steps she can take to improve self-

control and emotional regulation.  

(2) 

   

Q.8 Distinguish between Franchise-based self-employment and Freelance self-employment in two 

points.  

(2) 

   

Q.9 Mention two key challenges for sustainable urban water supply and two possible mitigation 

measures.  

(2) 

   

Q.10 List four basic practices a user should follow to keep workplace data secure from malware and 

theft. 

(2) 

   

 Answer any 4 out of the given 5 questions in (20–30 words) (4 × 2 = 8 marks)  

Q.11 Name any two style categories in Writer and write one feature of each. (2) 
   

Q.12 What precaution is recommended before turning on Record Changes in a document?  (2) 
   

Q.13 Differentiate between One-to-Many and Many-to-Many relationships with a simple example 

for each. 

(2) 

   

Q.14 State two common causes of electrical hazards at the workplace and one preventive measure. (2) 
   

Q.15 What is a macro? Give two situations from office work where a macro can save time.  (2) 
   

Q.16 While checking a machine you find a colleague in contact with a live conductor. List the 

safety steps to rescue the victim safely.  

(2) 

   

 Answer any 3 out of the given 5 questions in 50–80 words each (3 × 4 = 12 marks)  

Q.17 A small design studio is preparing a festival brochure in LibreOffice Writer. During layout 

work they face these following issues:  

(i) Two decorative images cover important text and need reordering;  

(ii) the title image on the back cover must remain centered regardless of added content;  

(iii) in a multi-column article, text must wrap around an inserted infographic;  

(iv) a sponsor graphic must always appear on top of other objects. 

 

(A) Which feature will fix the problem of images covering important text? 

(B) Which positioning setting keeps the back-cover title image centered as content changes? 

(C) Which wrap/anchor option allows text to flow around the infographic smoothly? 

(D) Which arrangement tool ensures the sponsor graphic stays above all elements? 

(4) 

   

Q.18 Consider the table given below and answer the questions that follow: (4) 

 Student Name Admission No. Class Total Marks 

Karan Patel 201 10A 442 

Sneha Verma 202 10B 458 

Vikram Rao 203 10A 475 

Meera Joshi 204 10C 449 
 

 

   

 (A) Name all the fields in the table  

 (B) Which field should be chosen as Primary Key?  

 (C) Suggest any one possible alternate key.  

 (D) Explain how a Primary Key differs from a Foreign Key using a simple example.  

   

Q.19 Musculoskeletal disorders may develop from prolonged poor posture and unsuitable seating 

while working on computers. List four practical measures to prevent these problems. 

(4) 
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Q.20 Nisha maintains an Events database. She has a master table CategoryMaster and a child table 

EventList which uses CategoryID to refer to CategoryMaster. 

(4) 

 (A) Define referential integrity and give one example using Nisha's tables.  

 (B) To prevent deleting a category that is still referenced in EventList, which relational option 

should be used? 

 

 (C) If CategoryID in CategoryMaster is changed and 'Update Cascade' is enabled, explain its 

effect on EventList with an example. 

 

 (D)  If 'Set NULL' is chosen and a master record is removed, what happens in the EventList? 

How is this behaviour different from 'Set Default'? 

 

   

Q.21 Akshay prepared a multi-sheet project workbook in Calc and inserted an absolute hyperlink to 

another file on his computer. When he shared the workbook, the hyperlink failed. He learns 

about relative hyperlinks and the 'Target in Document' option and also wants to fetch live 

tables from a government site into his sheet. 

(4) 

 (A) Why did the absolute hyperlink fail when shared, and how would a relative hyperlink 

resolve this? 

 

 (B) How does the 'Target in Document' option help navigate large workbooks?  

 (C) Which feature should Akshay use to import live tables from a website and why is it 

useful? 

 

 (D) How can Akshay later edit or remove a hyperlink in Calc?  
 


